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EBOOK SAKTI 
MICROSOFT WORD DASAR 

Tutorial Microsoft Word: Mengenal Microsoft Office 
Perkenalkan, nama saya Muhammad Fadhilah Arsha, atau biasa 

dipanggil Kak Arsha. Pada kelas ini, kita akan mempelajari materi 

tentang Microsoft Word. 

Untuk membuka aplikasi Microsoft Word, kita bisa mengakses 

menu Start pada laptop. Ketikkan "Word" di kolom pencarian, dan 

aplikasi dengan nama "Word" akan muncul. Jika aplikasi tidak 

tersedia, kita perlu menginstal Microsoft Office terlebih dahulu. 

 

Gambar: Membuka Microsoft Word 

Tutorial Microsoft Word: Memulai Dokumen Baru 
Setelah membuka Microsoft Word, untuk memulai proyek, klik 

tombol Blank Document. Dengan mengklik tombol tersebut, 

halaman kerja Microsoft Word akan terbuka. Di sini, kita dapat 
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melihat berbagai menu seperti Home, Insert, Draw, Design, dan 

lainnya.  

 

Gambar: Membuka Blank Document 
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Tutorial Microsoft Word: Fitur-Fitur di Microsoft Word 
Setiap menu memiliki fitur-fitur yang dapat kita gunakan. Sejak 

Office 2007, kita dapat langsung mengklik ikon-ikon fitur untuk 

menggunakan layanan dari Microsoft Word. 

 

Gambar: Menu-menu Microsoft Word  

Di bagian bawah menu, kita dapat melihat lembar kerja yang 

berwarna putih. Untuk mengisi konten, cukup klik di halaman 

putih tersebut dan ketik menggunakan keyboard. Contohnya, 

"Penulis makan nasi." 

 

Gambar: Mengisi Konten 

Di sebelah kanan bawah, terdapat fitur Zoom In dan Zoom 

Out yang berfungsi untuk memperbesar atau memperkecil 

tampilan layar.  
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Sementara itu, di sebelah kiri, terdapat informasi mengenai jumlah 

halaman dan posisi kita saat ini.  

Misal, jika kita menekan Enter hingga mencapai halaman kedua, 

akan muncul keterangan "Page 2 of 2," yang berarti kita berada di 

halaman kedua dari dua halaman.  

Jika kita kembali ke halaman pertama, akan muncul "Page 1 of 2," 

dan jumlah kata dalam dokumen kita juga akan ditampilkan, misal 

"3 kata: Penulis makan nasi." 

 

Gambar: Membuka Microsoft Word 

Demikian pengantar dari penulis mengenai Microsoft Word. Kita 

akan mempelajari banyak hal menarik dalam kelas ini. Sampai 

jumpa di materi berikutnya! 

Tutorial Microsoft Word: Page Setup 
Pada materi kali ini, kita akan mempelajari Page Setup, yaitu 

pengaturan awal yang perlu kita lakukan sebelum mulai proyek 

dengan Microsoft Word.  
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Langkah pertama adalah mengatur satuan ukuran dari inci ke 

sentimeter. Untuk melakukannya, ikuti langkah-langkah berikut: 

Klik menu File di bagian atas. Pilih Options. 

 

Gambar: Menu Options 

Di jendela yang muncul, masuk ke submenu Advanced. 
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Gambar: Submenu Advanced 

Gulir ke bawah hingga menemukan bagian Show 

measurement in unit of. Pastikan pilihan ini diatur ke cm. 

Lalu klik OK untuk menyimpan pengaturan. 

Setelah mengatur satuan ukuran, kita akan melanjutkan ke 

pengaturan margin. Margin adalah batas tepi pada dokumen yang 

membantu kita dalam penataan teks. Untuk mengatur margin: 

Klik menu Layout. Lalu pilih tombol Margins. 

 

Gambar: Menu Layout -> Margin 

Di sini, Kita akan melihat beberapa pilihan margin, 

seperti Normal dan Narrow. Jika ingin mengatur margin 

secara kustom, pilih Custom Margins. 
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Gambar: Custom Margins 

Kita dapat mengatur margin atas, kiri, bawah, dan kanan 

sesuai kebutuhan. Misal, atur margin atas menjadi 4 cm, 

kiri 4 cm, bawah 3 cm, dan kanan 3 cm. 

 

Gambar: Hasil Custom Margin 
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Selanjutnya, kita akan mengatur orientasi halaman. Di 

menu Layout, Kita akan menemukan opsi Orientation. Terdapat 

dua pilihan: 

• Portrait (vertikal) 

• Landscape (horizontal) 

Pilih orientasi yang sesuai dengan kebutuhan dokumen Kita. 

 

Gambar: Menu Layout -> Orientation 

Kita juga dapat mengatur ukuran halaman. Di menu Layout, 

pilih Size. Di sini, Kita akan menemukan berbagai pilihan ukuran 

kertas, seperti A4, Legal, dan A3. Ukuran default adalah A4.  
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Gambar: Menu Layout -> Size 

Hal lain yang sering digunakan dalam pengaturan halaman 

adalah kolom. Di menu Layout, Kita dapat mengatur jumlah kolom 

yang diinginkan, misal menjadi 2 atau 3 kolom, sesuai dengan 

kebutuhan dokumen. 

 

Gambar: Menu Layout -> Column 



 
14 | Ebook Sakti Microsoft Word 

 

Demikianlah penjelasan mengenai Page Setup pada Microsoft 

Word. Silakan praktekkan langkah-langkah di atas untuk mengatur 

dokumen Kita dengan lebih baik.  

Tutorial Microsoft Word: Teks 
Pada materi ini, kita akan mengenal teks dalam Microsoft Word. 

Mari kita mulai dengan memahami beberapa istilah yang penting 

dalam Microsoft Word.  

Ketika penulis mengetik huruf "A", huruf tersebut disebut karakter. 

Kumpulan huruf membentuk sebuah kata (word), dan kumpulan 

kata dapat membentuk sebuah kalimat (sentence). Jika kita 

memiliki minimal dua kalimat yang tersusun, itu 

dinamakan paragraf. 

 

Gambar: Istilah Penting dalam Microsoft Word 

Tutorial Microsoft Word: Pengaturan Teks 
Kita dapat mengatur pengaturan teks pada bagian Home. 

Contohnya, kita bisa mengatur font size. Pertama, blok kata yang 
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ingin diubah, misal "penulis". Kemudian, pilih ukuran font di 

bagian ini, misal kita ubah menjadi ukuran 20.  

 

Gambar: Mengatur Font Size 

Selain itu, ada istilah font yang merujuk pada jenis huruf. Jika kita 

blok kata atau kalimat yang ingin dipilih, misal "Penulis makan 

nasi", kita bisa mengubah font dari Calibri menjadi Times New 

Roman, sehingga gaya tulisan berubah. 
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Gambar: Mengubah Jenis Font 

Untuk mengubah ukuran font, kita juga bisa menggunakan tombol 

dengan huruf "A" di sini, yang memiliki simbol A besar dan A kecil. 

Misal, kita bisa memperbesar atau memperkecil ukuran font. 
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Gambar: Mengubah Ukuran Font dengan Tombol A 

Selanjutnya, di bagian Home, terdapat beberapa pengaturan lain 

yang bisa kita gunakan. Ada opsi Bold untuk menebalkan 

tulisan, Italic untuk memiringkan tulisan, dan Underline untuk 

memberi garis bawah pada tulisan.  

 

Gambar: Pengaturan Bold Italic & Underline 

Contohnya, jika kita memilih Bold pada tulisan "penulis" ,  maka 

tulisan "penulis" akan menjadi tebal. Jika penulis memilih Italic 

pada tulisan "makan", maka tulisan "makan" akan miring, dan jika 
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penulis memilih Underline pada tulisan "nasi", maka tulisan "nasi" 

akan bergaris bawah.  

 

Gambar: Penerapan Bold Italic & Underline 

Kita juga bisa menggabungkan semua pengaturan ini, misal dengan 

membuat tulisan "penulis" menjadi Bold, miring, dan bergaris 

bawah sekaligus. 
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Gambar: Mengubah Tulisan Bold Italic & Underline Sekaligus 

Pada halaman Home, kita juga dapat mewarnai tulisan. Misal, 

penulis ingin mengubah warna tulisan menjadi merah, atau bisa 

juga memilih warna lain seperti hijau, biru, dan sebagainya. Sebagai 

contoh, penulis pilih warna ungu. 

 

Gambar: Mengubah Warna Teks 

Tutorial Microsoft Word: Perataan Teks 
Di bagian Home, terdapat fitur perataan yang sering kita gunakan. 

Pertama, penulis telah membuat empat paragraf untuk 

menunjukkan perataan. 
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Gambar: Contoh Empat Paragraf 

Untuk paragraf pertama, kita bisa mengatur perataan 

menjadi Align Left, sehingga perataan akan berada di 

sebelah kiri. 

 

Gambar: Mengatur Align Left 
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Untuk paragraf kedua, kita blok dan ubah perataan 

menjadi Center, sehingga hasilnya akan berada di tengah. 

 

Gambar: Mengatur Align Center 

 

Untuk paragraf ketiga, kita blok dan pilih Align Right, 

sehingga paragraf akan berada di sebelah kanan. 
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Gambar: Mengatur Align Right 

Terakhir, ada opsi Justify, yang jika kita pilih, akan 

membuat teks rata di kedua sisi, kanan dan kiri. 

 

Gambar: Mengatur Align Justify 

Itulah penjelasan mengenai pengaturan teks, termasuk pengaturan 

font, ukuran, dan perataan dalam Microsoft Word. 

Tutorial Microsoft Word: Heading 
Pada materi kali ini, kita akan mengenal Heading. Heading sangat 

diperlukan ketika kita membuat sebuah dokumen yang 

memerlukan daftar isi, sehingga memudahkan kita saat menyusun 

daftar isi tersebut. 

Tutorial Microsoft Word: Apa itu Heading ? 
Heading adalah format yang digunakan untuk judul dalam 

dokumen. Sebagai contoh, penulis telah membuat sebuah artikel 

yang terdiri dari judul, konten, dan sub-sub judul. Untuk 

menggunakan Heading, kita dapat memformat judul dengan cara 

memblok teks yang ingin dijadikan Heading. 
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Gambar: Contoh Artikel 

Tutorial Microsoft Word: Cara Menggunakan Heading 
Memblok Teks: Pertama, blok teks yang ingin Kita format sebagai 

Heading. 

 

Gambar: Memblok Teks 

Menu Home: Masuk ke menu Home. Di sini, Kita akan 

menemukan bagian Styles. 
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Gambar: Menu Home -> Styles 

Memilih Heading: Pilih Heading yang sesuai. Untuk judul utama, 

pilih Heading 1.  

 

Gambar: Mengatur Heading 1 

Setelah itu, kita juga akan mengatur bagian submenu sebagai 

Heading. Blok teks tersebut dan pilih Heading 2 untuk sub judul. 
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Gambar: Mengatur Heading 2 

Tutorial Microsoft Word: Mengatur Format Heading 
Jika Kita ingin mengubah warna atau format dari Heading, Kita 

dapat melakukannya dengan cara berikut: 

Klik Kanan: Klik kanan pada Heading yang ingin diubah, lalu 

pilih Modify. 

 

Gambar: Modify Heading 
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Pengaturan Format: Di sini, Kita dapat mengatur berbagai format, 

seperti jenis font, ukuran font, serta menambahkan efek 

seperti Bold, Italic, atau Underline.  

Misal, Kita dapat mengatur Heading 2 menjadi font Times New 

Roman, ukuran 12, dengan efek Bold dan warna hitam. 

 

Gambar: Mengatur Format Heading 

Setelah mengklik OK, semua Heading 2 yang Kita format akan 

berubah sesuai pengaturan yang telah Kita buat. 

Itulah cara penggunaan Heading pada Microsoft Word. Dengan 

menggunakan Heading, Kita dapat dengan mudah menyusun 

dokumen dan membuat daftar isi secara otomatis, yang sangat 

berguna dalam penulisan dokumen ilmiah, seperti skripsi atau 

laporan.  

Tutorial Microsoft Word: Membuat Daftar Isi 
Pada bab kali ini, kita akan mempelajari cara membuat daftar isi di 

Microsoft Word. Sebelumnya, kita telah membahas secara singkat 

tentang penggunaan Heading dalam dokumen.  
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Heading ini sangat berguna untuk memudahkan pembuatan daftar 

isi. Misal, kita memiliki Heading 1, Heading 2, dan seterusnya. 

Sekarang, mari kita buat daftar isi di bagian bawah dokumen kita. 

Tutorial Microsoft Word: Langkah-Langkah Membuat 
Daftar Isi 
Membuat Halaman Baru: Pertama, kita perlu membuat halaman 

baru untuk daftar isi. Caranya, klik Insert, lalu pilih Blank Page. 

Halaman baru akan muncul di dokumen Kita. 

 

Gambar: Menu Insert -> Black Page 

Mengakses Menu References: Setelah halaman baru siap, fokuslah 

pada menu References. Klik menu ini, dan Kita akan menemukan 

opsi Table of Contents. 
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Gambar: Menu References -> Table of Contents 

Memilih Gaya Daftar Isi: Di dalam menu Table of Contents, 

terdapat beberapa pilihan gaya daftar isi. Pilihlah yang paling 

sesuai dengan kebutuhan Kita, misal pilihan yang paling atas. 

 

Gambar: Memilih Daftar Isi 
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Mengatur Daftar Isi: Setelah memilih, daftar isi akan otomatis terisi 

berdasarkan Heading yang telah Kita buat. Heading 1 akan berada 

di paling kiri, dan Heading 2 akan memiliki indentasi lebih ke 

dalam. 

 

Gambar: Istilah Penting dalam Microsoft Word 

Mengupdate Daftar Isi:Jika Kita melakukan perubahan pada 

dokumen, seperti memindahkan Heading ke halaman lain, Kita 

perlu mengupdate daftar isi agar nomor halaman sesuai. 
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Gambar: Memindahkan Heading ke Halaman Lain 

Cara Mengupdate: Klik kanan pada daftar isi, lalu pilih Update 

Table. 

 

Gambar: Update Table 



 

Ebook Sakti Microsoft Word | 31  

 

Pilih Update Entire Table untuk memperbarui seluruh konten dan 

nomor halaman. 

 

Gambar: Update Entire Table  

Klik OK, dan daftar isi Kita akan diperbarui sesuai perubahan yang 

telah dilakukan. 

 

Gambar: Hasil Update Entire Table  
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Membuat daftar isi di Microsoft Word sangatlah mudah dengan 

menggunakan menu References dan Table of Contents.  

Tutorial Microsoft Word: Indent dan Ruler 
Pada materi kali ini, kita akan mempelajari 

tentang indent dan ruler di Microsoft Word. Apa itu Indent dan 

Ruler? 

 

Gambar: Menu Indent 

• Indent adalah ruang kosong yang digunakan untuk 

menjorokkan teks dari batas kiri atau kanan paragraf. 

• Ruler adalah penggaris yang membantu kita mengatur 

posisi teks dan margin dalam dokumen. 
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Tutorial Microsoft Word: Menggunakan Indent 
Di dalam dokumen kita, terdapat paragraf yang bisa kita atur. 

Pertama, kita akan masuk ke tab Home. Di sini, kita akan 

menemukan tombol untuk Decrease Indent dan Increase Indent. 

 

Gambar: Menu Indent 

Sebagai contoh, penulis akan menggunakan Increase Indent untuk 

memberikan ruang kosong pada paragraf pertama. Arahkan kursor 

ke paragraf tersebut, lalu klik tombol Increase Indent.  
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Gambar: Menu Indent 

Dengan melakukan ini, akan ada ruang kosong di sebelah kiri 

paragraf. Jika ingin menambah ruang lagi, cukup klik tombol 

tersebut sekali lagi. Kita juga bisa menggunakan Decrease 

Indent untuk mengurangi ruang yang telah ditambahkan. 
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Tutorial Microsoft Word: Menggunakan Ruler 
Selanjutnya, kita akan membahas tentang Ruler. Jika Kita tidak 

melihat penggaris di atas atau di samping dokumen, Kita bisa 

mengaktifkannya melalui menu View dan centang opsi Ruler. 

 

Gambar: Menu View -> Ruler 

Jika penggaris yang muncul masih menggunakan sistem inci, Kita 

bisa mengubahnya ke sentimeter. Caranya, masuk ke menu File, 

pilih Options, lalu pilih Advanced.  
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Gambar: Menu View -> Ruler 

Di bagian Measurement units, pilih Centimeters dan klik OK. 

Sekarang, penggaris akan ditampilkan dalam sentimeter. 

Tutorial Microsoft Word: Mengatur Margin dengan 
Ruler 
Dengan menggunakan ruler, kita bisa mengatur margin dokumen. 

Sebelumnya, kita telah mengatur margin melalui menu Layout. 

Namun, kita juga bisa melakukannya langsung dari ruler. 
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Gambar: Mengatur Margin Lewat Menu Layout 

Di sisi kiri ruler, Kita akan melihat pengatur untuk margin atas. Kita 

bisa mengubahnya dengan menggeser pengatur tersebut.  

 

Gambar: Mengatur Margin Atas dengan Sisi Kiri Ruler 
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Misal, jika Kita ingin memperpanjang margin, cukup geser 

pengatur ke arah yang diinginkan. Jika Kita ingin mengatur margin 

kiri, Kita juga bisa melakukannya dengan cara yang sama. 

Tutorial Microsoft Word: Mengatur Indensitas Baris 
Pertama 
Selain itu, kita juga bisa mengatur First Line Indent menggunakan 

ruler. Di bagian atas ruler, terdapat panah yang mengarah ke 

bawah. Ini berfungsi untuk mengatur indentasi pada baris pertama 

paragraf.  

 

Gambar: First Line Indent 

Misal, jika Kita ingin mengatur First Line Indent menjadi 3 cm, 

geser panah tersebut ke angka 3 cm. Dengan demikian, akan ada 

ruang kosong di awal paragraf. 
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Gambar: Mengatur First Line Indent Menjadi 3cm 

Kita juga bisa mengatur Left Indent di bagian bawah ruler. Misal, 

jika Kita ingin mengatur Left Indent menjadi 2 cm, geser pengatur 

tersebut ke angka 2 cm.  

 

Gambar: Mengatur Left Indent Menjadi 2cm 
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Hasilnya, indentasi akan terlihat seperti ini: 2 cm untuk left indent 

dan 3 cm untuk first line indent. 

Itulah penjelasan mengenai indent dan ruler di Microsoft Word. 

Dengan memahami cara menggunakan kedua fitur ini, Kita dapat 

membuat dokumen yang lebih terstruktur dan rapi.  

Tutorial Microsoft Word: Bullets dan Numbering 
Pada materi kali ini, kita akan mempelajari tentang Bullets dan 

Numbering di Microsoft Word. 

Tutorial Microsoft Word: Apa Itu Bullet? 
Bullet adalah sebuah daftar tidak terurut (unordered list) yang 

digunakan untuk menkitai poin-poin dalam teks. Jika kita masuk ke 

menu Home, kita akan menemukan ikon yang menampilkan poin-

poin. Inilah yang disebut dengan Bullet.  

 

Gambar: Contoh Artikel 

Sebagai contoh, penulis telah membuat sebuah paragraf yang berisi 

daftar vitamin seperti vitamin C, A, Kalium, dan serat.  
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Gambar: Contoh Daftar Vitamin 

Untuk mengubahnya menjadi daftar dengan Bullet, kita perlu 

memisahkan setiap item ke baris baru, misalnya: 

• Vitamin A 

• Vitamin C 

• Kalium 

• Serat 

Setelah itu, kita blok teks tersebut dan klik ikon Bullet. Maka, teks 

akan berubah menjadi daftar dengan Bullet.  
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Gambar: Menerapkan Daftar Bullet 

Jika kita ingin mengubah gaya Bullet, kita bisa klik tombol panah di 

samping ikon Bullet dan memilih berbagai macam gaya Bullet yang 

tersedia, termasuk yang berwarna. 

Tutorial Microsoft Word: Apa Itu Numbering? 
Numbering adalah fitur penomoran yang digunakan untuk 

membuat daftar terurut (ordered list). Misalnya, kita memiliki 

daftar vitamin B seperti folat, riboflavin, dan niacin. Sama seperti 

sebelumnya, kita perlu memisahkan setiap item ke baris baru: 

1. Folat 

2. Riboflavin 

3. Niacin 

Kemudian, kita blok teks tersebut dan klik ikon Numbering yang 

berada di sebelah kanan ikon Bullet. Numbering akan mengubah 

teks menjadi daftar bernomor.  
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Gambar: Mengatur Penomoran dengan Numbering 

Kita juga bisa mengubah gaya penomoran dengan mengklik tombol 

panah di samping ikon Numbering, dan memilih format yang 

diinginkan, seperti angka, huruf, atau angka Romawi. 
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Ini berguna untuk menyesuaikan tampilan daftar agar lebih rapi. 

Dengan memahami cara menggunakan Bullets dan Numbering, 

kita dapat membuat dokumen yang lebih terstruktur dan mudah 

dibaca.  

Tutorial Microsoft Word: Spacing 
Pada bab kali ini, kita akan membahas tentang spacing atau spasi. 

Namun, perlu kita ketahui bahwa spasi yang dimaksud di sini 

bukanlah spasi antar huruf, melainkan spasi antar baris. Jadi, 

spacing adalah jarak atau spasi yang terdapat di antara baris-baris 

teks. 

 

Gambar: Menu Line & Paragraf Spacing 

Tutorial Microsoft Word: Langkah-Langkah Mengatur 
Spacing 
Berikut adalah langkah-langkah yang perlu kita lakukan untuk 

mengatur spacing: 

Memilih Teks: Pertama-tama, kita perlu memblok atau memilih 

bagian teks yang ingin kita atur spacing-nya. Misal, jika kita ingin 



 

Ebook Sakti Microsoft Word | 45  

 

mengubah spacing untuk seluruh dokumen, kita bisa 

menggunakan shortcut Ctrl + A untuk memblok semua teks. 

 

Gambar: Memblok Semua Teks 

Mengakses Menu Spacing: Setelah teks terblok, kita akan melihat 

opsi spacing di bagian Home. Di sini, terdapat 

kategori Paragraf dengan ikon Line and Paragraph Spacing. Kita 

bisa mengklik ikon tersebut untuk melihat pilihan spacing yang 

tersedia. 
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Gambar: Mengakses Menu Spacing 

Memilih Jenis Spacing: Di menu yang muncul, kita bisa memilih 

jenis spacing yang diinginkan, seperti 1, 1.5, 2, dan seterusnya. 

Misal, jika kita ingin mengatur spacing menjadi 1.5, kita tinggal 

memilih opsi tersebut. Jika kita memilih spacing 1, maka teks akan 

terlihat lebih rapat. 

 

Gambar: Menagtur Jenis Spacing Menjadi 1.5 
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Tutorial Microsoft Word: Mengatur Spacing Sebelum & 
Sesudah Paragraf 
Selanjutnya, kita juga bisa mengatur before dan after space pada 

paragraf. Di bagian pengaturan spacing, terdapat opsi 

untuk remove space. Jika kita memilih opsi ini, maka tidak akan ada 

jarak antara paragraf, baik sebelum maupun sesudahnya. 

 

Gambar: Mengakses Meni Before & After Space 

Sebagai contoh, jika kita menggunakan spacing 1 dan kemudian 

menambahkan add space before, akan ada jarak tambahan sebelum 

setiap paragraf. Sebaliknya, jika kita memilih remove, maka 

paragraf akan terlihat lebih rapat. 
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Gambar: Penerapan Add Space Before 

Tutorial Microsoft Word: Opsi Lanjutan untuk 
Mengatur Spacing  
Kita juga bisa mengatur lebih lanjut melalui tombol yang sama 

dengan mengklik Line Spacing Options. Di sini, kita dapat 

menentukan jarak antar paragraf.  

 

Gambar: Mengakses Line Spacing Options 
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Terdapat beberapa pilihan seperti single, double, dan lainnya. 

Misal, kita bisa mengatur spacing menjadi 3 pt untuk jarak sebelum 

dan sesudah paragraf. Setelah mengatur, jangan lupa untuk 

mengklik OK agar perubahan diterapkan. 

 

Gambar: Mengatur Line Spacing Options 

Dengan mengikuti langkah-langkah di atas, kita dapat mengatur 

spacing di Microsoft Word dengan lebih rapi dan teratur. Semoga 

materi ini bermanfaat bagi kita dalam membuat dokumen yang 

lebih profesional dan enak dibaca.  

Tutorial Microsoft Word: Tabel 
Pada materi kali ini, kita akan mempelajari materi baru, 

yaitu tabel di Microsoft Word.  

Tutorial Microsoft Word: Memasukan Tabel 
Untuk memasukkan tabel, langkahnya sangat mudah. Pertama, 

buka menu Insert. Di sana, Kita akan menemukan fitur Table. 



 
50 | Ebook Sakti Microsoft Word 

 

 

Gambar: Menu Insert -> Table 

Jika kita klik di sini, kita bisa menggunakan opsi Insert Table yang 

instan. Kita hanya perlu mengarahkan pointer mouse ke jumlah 

baris dan kolom yang ingin dibuat.  

Misal, jika kita ingin membuat tabel dengan 3 kolom dan 6 baris, 

arahkan pointer ke 3 kolom dan 6 baris, lalu klik. Tabel dengan 3 

kolom dan 6 baris pun akan muncul. 
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Gambar: Membuat Tabel 3 Kolom 6 Baris 

Tutorial Microsoft Word: Mengisi Konten Tabel 
Untuk mengisi konten tabel, cukup klik pada sel yang ingin diisi. 

Misal, pada baris pertama kolom pertama, kita bisa 

mengetikkan nomor.  

Di kolom kedua baris pertama, kita bisa menuliskan nama 

makanan, dan di kolom ketiga baris pertama, kita bisa 

menambahkan manfaat.  

Setelah itu, tabel akan terisi dengan informasi yang kita masukkan. 

Jika kita mengklik di luar tabel, pengaturan akan hilang, tetapi tabel 

tetap ada. 
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Gambar: Mengisi Kolom Tabel 

Tutorial Microsoft Word: Mengatur Desain Tabel 
Ketika kita kembali ke tabel, akan muncul menu baru yaitu Table 

Design. Di sini, kita bisa memilih tema untuk tabel, seperti warna 

hijau dan lain-lain.  

 

Gambar: Menu Table Design -> Plain Tables 
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Jika kita ingin agar header tabel selalu muncul di halaman baru, kita 

bisa memilih baris header, lalu pergi ke menu Layout dan 

klik Repeat Header Row. Ini berguna jika tabel kita memiliki 

banyak baris, sehingga header tetap terlihat di setiap halaman. 

 

Gambar: Menu Layout -> Repeat Header Row 

Tutorial Microsoft Word: Membuat Tabel Baru 
Jika kita ingin membuat tabel baru, kita bisa kembali ke menu Insert 

Table.  

Misal, jika kita ingin membuat tabel dengan 30 baris dan 4 kolom, 

kita bisa memasukkan jumlah kolom dan baris yang diinginkan.  

Setelah mengklik OK, tabel baru dengan jumlah yang kita tentukan 

akan terbentuk. 
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Gambar: Membua Tabel Baru dengan Insert Table 

Tutorial Microsoft Word: Mengatur Border Tabel 
Pada bagian Table Design, kita juga bisa mengatur border tabel. 

Pilih semua kolom, lalu pilih warna border yang diinginkan, 

misal hitam.  
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Kita bisa memilih format border seperti Outside Border, No 

Border, atau All Border untuk mengatur tampilan tabel sesuai 

keinginan. 

 

Gambar: Mengatur Border Tabel 

Tutorial Microsoft Word: Menggabungkan Sel (Merge 
Cells) 
Di menu Layout, kita juga bisa melakukan merge cells. Merge cells 

adalah penyatuan beberapa sel menjadi satu.  

Misal, kita bisa menyatukan semua sel di baris pertama kolom 

pertama dan kedua.  

Setelah memilih sel yang ingin digabung, klik Merge. Hasilnya, sel 

tersebut akan menyatu dan terlihat lebih besar. 
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Gambar: Mengatur Merge Cells 

Itu dia penjelasan mengenai cara membuat dan mengatur tabel di 

Microsoft Word. Silakan eksplorasi lebih lanjut pada bagian Table 

Design dan Layout untuk menemukan berbagai fitur menarik 

lainnya.  
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Tutorial Microsoft Word: Page Number 
Pada materi kali ini, kita akan membahas tentang penomoran 

halaman atau page number di Microsoft Word. Menambahkan 

penomoran halaman sangatlah mudah.  

Pertama, buka menu Insert. Di sini, Kita akan menemukan 

fitur Page Number. Klik pada opsi tersebut, dan Kita akan melihat 

beberapa pilihan untuk penomoran halaman, baik di bagian atas 

maupun di bawah halaman. 

 

Gambar: Menu Insert -> Page Number 

Sebagai contoh, penulis akan menggunakan penomoran di bawah 

halaman. Kita dapat memilih berbagai style yang tersedia, baik 

yang sederhana maupun yang memiliki tambahan desain. Misal, 

penulis akan memilih style yang bernama "Assign Bar 4". 
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Gambar: Memilih Style Assign Bar 4 

Setelah memilih style, nomor halaman akan muncul secara 

otomatis. Kita juga akan melihat teks template yang 

bertuliskan "Page". Mari kita ubah teks ini menjadi "Makalah Karya 

Penulis" sebagai contoh. 

 

Gambar: Mengubah Teks Template 
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Untuk kembali fokus pada konten, cukup klik dua kali pada area 

konten dokumen. Sekarang, Kita akan melihat penomoran halaman 

yang berurutan, seperti halaman 1, halaman 2, halaman 3, dan 

seterusnya. 

 

Gambar: Kembali ke Fokus Konten 

Tutorial Microsoft Word: Menambahkan Halaman 
Sampul 
Jika Kita ingin menambahkan halaman sampul, Kita bisa 

membuat Blank Page di awal dokumen. Misal, kita 

tambahkan cover di sini. 
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Gambar: Membuat Blank Page untuk Sampul 

Namun, jika Kita ingin menghilangkan nomor halaman pada 

halaman sampul, cukup klik pada Page Number dan pilih 

opsi Different First Page. Dengan cara ini, nomor halaman tidak 

akan muncul di halaman pertama. 

 

Gambar: Mengaktifkan Differents First Page pada Sampul 
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Tutorial Microsoft Word: Mengatur Nomor Halaman 
Selanjutnya, kita bisa mengatur nomor halaman agar dimulai dari 

angka nol. Kembali ke menu Page Number, pilih Format Page 

Number, dan ubah Start at menjadi nol.  

 

 

Gambar: Mengatur Nomor Halaman Agar Dimulai dari 0 
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Dengan pengaturan ini, halaman pertama setelah cover akan 

menjadi halaman 1, sementara halaman cover tidak akan memiliki 

nomor. 

 

Gambar: Hasil mengatur Nomor Halaman yang Dimulai dari 0 

Tutorial Microsoft Word: Mengubah Format Nomor 
Halaman 
Selain itu, Kita juga dapat mengubah format nomor halaman. Misal, 

jika Kita ingin menggunakan angka Romawi atau huruf, Kita bisa 

kembali ke menu Header and Footer.  
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Gambar: Format Page Number 

Klik pada Page Number, lalu pilih Format Page Number. Di sini, 

Kita dapat memilih format yang diinginkan, seperti angka Romawi 

atau huruf. 

 

Gambar: Pengaturan Format Page Number 
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Dengan langkah-langkah di atas, Kita dapat dengan mudah 

menambahkan dan mengatur penomoran halaman di Microsoft 

Word.  

Tutorial Microsoft Word: Header dan Footer 
Selain menambahkan nomor halaman di bagian bawah dokumen, 

kita juga bisa mengatur header dan footer.  

Header adalah bagian di atas konten utama, sedangkan footer 

berada di bawah konten utama, tepat di area margin.  

Berikut adalah cara untuk mengatur header dan footer di Microsoft 

Word: Masuk ke tab Insert di menu Word. Pilih 

opsi Header atau Footer sesuai kebutuhan . 

 

Gambar: Menu Insert -> Header & Footer 

Alternatif lainnya, Kita bisa langsung mengklik dua kali pada area 

header di bagian atas atau footer di bagian bawah dokumen. Ini 

akan membawa Kita langsung ke mode pengeditan header atau 

footer. 
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Gambar: Hasil Klik 2x Pada Bagian Header 

Setelah masuk ke mode pengeditan header, Kita akan melihat menu 

yang memungkinkan Kita memilih berbagai template header yang 

tersedia. 

Misal, Kita bisa memilih template yang menarik seperti "Retos 

Pack". Setelah memilih, template tersebut akan muncul di dokumen 

Kita. 
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Gambar: Memilih Template Header 

Isi informasi yang diperlukan, seperti judul dokumen atau tanggal. 

Misal, Kita bisa mengisi judul dengan "Manfaat Makan Buah-

buahan" dan tanggal dengan "26 September 2023". 

 

Gambar: Mengubah Isi Informasi 
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Untuk footer, prosesnya serupa dengan header. Namun, jika Kita 

sudah menambahkan nomor halaman di footer, Kita tidak bisa 

menambahkan elemen lain di sana karena akan menimpa nomor 

halaman yang sudah ada. 

Dengan mengikuti langkah-langkah di atas, Kita dapat dengan 

mudah menambahkan dan mengatur header dan footer di 

dokumen Word Kita.  

Tutorial Microsoft Word: WordArt 
Pada materi teks sebelumnya, kita telah mempelajari cara mengatur 

ukuran dan warna untuk memperindah judul atau konten kita.  

Namun, bagaimana jika kita ingin membuat judul yang lebih 

menarik daripada sekadar teks biasa atau warna stkitar? Di 

sinilah WordArt berperan. 

WordArt adalah fitur yang memungkinkan kita menambahkan 

tampilan artistik pada teks yang kita pilih. Untuk menggunakan 

WordArt, ikuti langkah-langkah berikut: 

Pilih Teks: Blok teks yang ingin Kita ubah menjadi WordArt. 
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Gambar: Blok Teks yang Ingin Diubah 

 

Masuk ke Menu Insert: Di dalam menu Insert, Kita akan 

menemukan pilihan WordArt. Klik opsi ini untuk melihat berbagai 

template dan gaya yang tersedia. 

 

Gambar: Pilihan WordArt 

Pilih Gaya: Pilih salah satu gaya WordArt yang Kita suka. Setelah 

memilih, teks yang telah Kita blok akan otomatis berubah sesuai 

dengan gaya yang dipilih. 
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Gambar: Penerapan WordArt 

Atur Ukuran dan Spacing: Kita dapat menyesuaikan ukuran dan 

jarak (spacing) teks agar lebih sesuai dan terlihat menarik. 

 

Gambar: Mengatur Ukuran & Spacing WordArt 
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Dengan menggunakan WordArt, Kita dapat memberikan sentuhan 

kreatif pada dokumen Kita, menjadikannya lebih menarik dan 

profesional.  

Tutorial Microsoft Word: Pictures and Shapes 
Menambahkan gambar ke dalam dokumen sangat penting untuk 

membuatnya lebih menarik dan tidak membosankan.  

Tutorial Pictures and Shapes: Menambahkan Gambar 
Untuk menambahkan gambar, langkah pertama adalah masuk ke 

menu Insert. Di sini, Kita akan menemukan opsi Pictures. Klik opsi 

tersebut, lalu pilih This Device untuk mencari file gambar yang ada 

di komputer Kita.  

 

Gambar: Insert Picture 

Gambar dapat berupa format JPEG, PNG, atau format lainnya. Pilih 

gambar yang telah Kita unduh dan simpan di perangkat Kita. 
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Setelah memilih gambar, Kita dapat memindahkannya dengan cara 

memotong (cut) dan menempelkannya (paste) di lokasi yang 

diinginkan dalam dokumen.  

 

Gambar: Hasil Insert Picture 

Tutorial Pictures and Shapes: Mengatur Gambar 
Setelah gambar ditambahkan, Kita dapat mengatur tampilannya. 

Klik pada gambar tersebut, dan menu baru bernama Picture 

Format akan muncul.  
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Gambar: Picture Format -> Correction 

Di sini, Kita dapat melakukan beberapa penyesuaian, seperti: 

• Correction: Mengatur kecerahan gambar, membuatnya 

lebih cerah, atau mengubah warnanya menjadi hitam putih. 

• Transparency: Mengatur tingkat transparansi gambar. 

• Styles: Menambahkan efek seperti bingkai, bayangan, atau 

mengubah bentuk gambar menjadi bulat. 

Jika ukuran gambar terlalu besar (misal lebih dari 5 MB), Kita dapat 

mengompresnya agar dokumen tidak terlalu berat. Caranya, klik 

gambar, lalu di menu Picture Format, pilih Compress Pictures.  
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Gambar: Format Picture -> Compress Picture 

Kita dapat memilih opsi untuk Print atau Web, kemudian klik OK. 

Gambar akan terkompres sehingga ukuran file menjadi lebih kecil. 
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Tutorial Pictures and Shapes: Menambahkan Efek dan 
Border 
Kita juga dapat menambahkan efek pada gambar, seperti Picture 

Border untuk menambahkan bingkai berwarna, atau Picture 

Effect untuk menambahkan bayangan, refleksi, dan lain-lain.  

Misal, untuk menambahkan bayangan, pilih efek Shadow dan pilih 

jenis bayangan yang diinginkan, seperti Outer. Bayangan akan 

muncul di sekitar gambar. 

 

Gambar: Picture Format -> Picture Border 

Tutorial Pictures and Shapes: Mengatur Posisi Gambar 
Jika gambar terlalu kecil, Kita dapat mengatur posisi gambar 

dengan menggunakan Wrap Text. Pilihan yang tersedia 

termasuk Inline with Text, Square, Behind Text, dan In Front of 

Text.  
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Gambar: Picture Format -> Warp Text 

Untuk gambar yang lebih kecil, pilih Square agar gambar dapat 

ditempatkan di area kosong dalam dokumen. 

Tutorial Pictures and Shapes: Menambahkan Shape 
Selain gambar, Kita juga dapat menambahkan Shapes. Kembali ke 

menu Insert, pilih Shapes untuk melihat berbagai bentuk yang 

tersedia. Misal, Kita dapat menambahkan bentuk kotak atau 

bintang.  
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Gambar: Insert -> Shapes 

Setelah menambahkan bentuk, Kita dapat mengatur warna dan 

outline-nya melalui menu Shape Format.  

 

Gambar: Shape Format 
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Misal, Kita dapat mengubah warna bentuk menjadi kuning dan 

outline menjadi merah. 

 

Gambar: Mengubah Warna Bentuk 

Dengan mengikuti langkah-langkah di atas, Kita dapat membuat 

dokumen Word yang lebih menarik dan interaktif dengan 

menggunakan gambar dan bentuk.  

Tutorial Microsoft Word: SmartArt dan Grafik 
Pada Microsoft Word, terdapat fitur yang sangat berguna 

yaitu SmartArt dan grafik. Fitur ini dapat diakses melalui 

menu Insert.  

SmartArt digunakan untuk membuat diagram dengan berbagai 

jenis yang dapat dipilih, sehingga memudahkan kita dalam 

menyajikan informasi secara visual tanpa perlu mendesainnya 

terlebih dahulu menggunakan aplikasi desain lainnya. 
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Gambar: Insert SmartArt Graphic 

Tutorial Microsoft Word: Menggunakan SmartArt 
Memilih SmartArt: Ketika Kita mengklik SmartArt, akan muncul 

berbagai jenis diagram yang bisa dipilih, 

seperti List, Process, Cycle, dan lain-lain.  

 

Gambar: Berbagai Jenis Diagram 
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Misal, jika kita ingin membuat diagram untuk menggambarkan 

langkah-langkah dari suatu metode, kita bisa memilih jenis Cycle. 

 

Gambar: Menambahkan Diagram Jenis Cycle 

Mengisi Teks: Setelah memilih diagram, klik OK untuk 

menampilkan diagram tersebut. Kita dapat mengisi teks pada setiap 

bagian diagram, misal: Tahap 1, Tahap 2, Tahap 3, Tahap 4, 

dan Tahap 5.  
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Gambar: Mengisi Teks Diagram 

Jika ingin menghapus salah satu tahap, cukup klik kanan pada 

tahap tersebut dan pilih Delete. Diagram akan otomatis 

menyesuaikan jumlah bagiannya. 

Kustomisasi: Di menu SmartArt Design, Kita dapat memilih warna 

dan gaya (style) yang diinginkan untuk mempercantik tampilan 

diagram. 
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Gambar: Kustomisasi Warna Diagram 

Mengubah Urutan: Kita juga dapat mengubah urutan tahap 

dengan menggunakan fitur Move Up atau Move Down.  

Misal, jika Kita ingin menjadikan Tahap 4 sebagai yang teratas, 

cukup pilih tahap tersebut dan gunakan opsi Move Up. 
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Gambar: Merubah Urutan 

Tutorial Microsoft Word: Menggunakan Grafik 
Menyisipkan Grafik: Selain SmartArt, Kita juga dapat 

menyisipkan grafik melalui menu Insert.  

 

Gambar: Menyisipkan Grafik 

Terdapat berbagai jenis grafik yang bisa dipilih, seperti diagram 

batang, diagram garis, dan diagram pie.  

Misal, jika Kita ingin menggunakan diagram pie, pilih jenis grafik 

tersebut dan klik OK. 
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Gambar: Merubah Urutan 

Mengisi Data: Setelah grafik muncul, Kita akan melihat jendela 

Excel untuk mengisi data. Misal, Kita dapat memasukkan data 

untuk tiga kategori makanan: 

o Makanan 1: 10 

o Makanan 2: 20 

o Makanan 3: 5 
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Gambar: Mengisi Data 

Setelah mengisi data, grafik akan otomatis menyesuaikan warna 

dan ukuran sesuai dengan data yang dimasukkan. 

 

Gambar: Menyesuaikan Warna 
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Mengedit Data: Jika Kita perlu mengubah data, cukup klik pada 

grafik dan pilih Chart Design, lalu pilih Edit Data.  

Kita juga dapat mengubah gaya grafik di bagian ini dengan memilih 

warna dan style yang diinginkan. 

Kesimpulan 

Dengan menggunakan fitur SmartArt dan grafik di Microsoft 

Word, Kita dapat dengan mudah membuat representasi visual dari 

informasi dan ide-ide Kita.  

Fitur-fitur ini tidak hanya mempercantik dokumen, tetapi juga 

membantu dalam menyampaikan informasi dengan lebih jelas dan 

menarik.  

Tutorial Microsoft Word: Equation dan Symbol 
Pada materi terakhir ini, kita akan mempelajari tentang Equation 

dan Symbol di Microsoft Word. Untuk membuka fitur ini, kita bisa 

masuk ke menu Insert.  

 

Gambar: Menu Insert -> Equation & Symbol 
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Di sana, terdapat pilihan Equation dan Symbol Equation berfungsi 

untuk membuat formulasi rumus, terutama yang bersifat 

matematis. Sementara itu, Symbol digunakan untuk 

menambahkan simbol-simbol yang tidak tersedia pada keyboard.  

Misalnya, jika kita ingin memasukkan simbol hak cipta (Copyright), 

kita bisa klik Insert, lalu pilih Symbol, dan kemudian More 

Symbols.  

 

Gambar: Jenis-Jenis Symbol 

Di sini, terdapat berbagai pilihan simbol yang bisa kita gunakan. 

Setelah memilih simbol hak cipta, klik Insert, dan simbol tersebut 

akan muncul di dokumen kita. Setelah itu, kita bisa melanjutkan 

mengetik teks lainnya. 
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Gambar: Penerapan Symbol Copyright 

Untuk Equation, caranya hampir sama. Kita bisa memasukkannya 

melalui menu Insert dan memilih Equation.  

 

Gambar: Jenis-Jenis Equation 
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Microsoft Word menyediakan berbagai format, seperti fraction, 

script, dan sebagainya, termasuk akar. Sebagai contoh, jika kita 

ingin membuat rumus seperti alog⁡b1blog⁡ablogaalogb1,  

Kita bisa memulainya dengan memilih Script, lalu 

pilih Subscript dan Superscript. Isikan dengan aa dan log⁡blogb.  

 

Gambar: Jenis Script -> Subscript & Superscript 
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Setelah itu, gunakan Fraction untuk memasukkan pecahan, dan 

isikan bagian atas dengan angka satu.  

 

Gambar: Menambahkan Fraction 

Untuk bagian bawah, gunakan kembali Script dan isikan 

dengan blog⁡abloga. 
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Gambar: Hasil Penerapan Equation 

Itulah materi mengenai Equation dan Symbol di Microsoft Word. 

Semoga bermanfaat! 
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